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Using this resource. 

 

This resource is not a text book. 

 

It contains material that is hoped will be covered as a dialogue between students 

and teacher and/or students and students. 

 

You, as a teacher, must plan carefully ‘your performance’. The inclusion of all the 

‘stuff’ is to support: 

• you (the teacher) in how to plan your performance – what questions to ask, 

when and so on, 

• the student that may be absent, 

• parents or tutors who may be unfamiliar with the way in which this approach 

unfolds. 

 

Professional development sessions in how to deliver this approach are available. 

 

Please contact: 

 

The Noel Baker Centre for School Mathematics 

Prince Alfred College, 

PO Box 571 Kent Town, South Australia, 5071 

Ph. +61 8 8334 1807 

Email: aharradine@pac.edu.au 

 

 

Legend. 
 

EAT – Explore And Think. 

These provide an opportunity for an insight into an activity from which mathematics 

will emerge – but don’t pre-empt it, just explore and think! 

 

 

At certain points the learning process should have generated some          

burning mathematical questions that should be discussed and pondered,  

and then answered as you learn more! 

 

 

Time to Formalise.  

These notes document the learning that has occurred up to this 

point,  

using a degree of formal mathematical language and notation. 

 

 

Examples. 

Illustrations of the mathematics at hand, used to answer questions. 
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1. Look hard … what do you see? 
 

Mathematical notation can be used to describe the behaviour of things that we see. 

If used well it is a simple and powerful tool.  

At best, behaviour can be fully captured by a few symbols – the fewer the better! 

 

 

1.1 EAT 1 

Open the ClassPad 300 geometry file dista1 (in the distrib folder) and run the 

animation that has been added.  

 

Your task is to describe / ‘name’ the thing(s) you see. 

It may help you to think about what changes and what stays the same. 

 

Record your descriptions.  

Compare and discuss these with your class. 

9.1  

  

 

 

1.2 EAT 2 

Repeat this for dista2 and dista3.  

Record and discuss the different ways that what you see can be described. 

 

 

 

1.3 EAT 3 

Explore and think in the same way about the sequence of animated geometry files 

distb1, distb2 and distb3. 

 

Explore and think in the same way about the sequence of animated geometry files 

distc1, distc2 and distc3. 
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One group who looked at the previous animations labelled the diagram (left) and 

saw 

)( zxy +×
 

yzxy +
 

 

Can you see what they are describing? 

Can you see how they chose to describe it? 

 

Another group saw 

)(2 zxy +×
 

)(2 yzxy +
 

yzxyyzxy +++
 

yzxy 22 +
 

)( zxyyzxy +×++
 

 

Can you see what they were describing? 

Can you see how they chose to describe it? 

 

 

 

 

These algebraic expressions can be thought of as  

non-identical mathematical twins 

They don’t look the same but they are essentially the 

same, equivalent in value and in a way, 

interchangeable1  

 

This ‘equivalence’ means that the expressions take the 

same value when values for the variables are assigned.  

 

Open the ClassPad 300 spreadsheet file distrib  

(in the distrib folder) to observe ‘equivalence’ in 

action. 

 

This spreadsheet focuses on the twins described by the 

first group above. 

 

If we are sure that these expressions return the same value for all possible values that 

the variables could take (a spreadsheet with infinite rows perhaps?) then we can say 

that they are equivalent and they can be linked by an = sign i.e. … 

                                                 

 

 
1
 Unlike human non-identical twins, who are unique individuals in their own right and 

are in no way interchangeable! 
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                 acabcba +=+ )(  

Or to put it another way 

                 )( cbaacab +=+  

This is commonly called the Distributive Law 

 

Note: Our demonstrations do not prove the equivalence needed to make this a 

mathematical law, but others have provided this proof, establishing it as law! 

 

1.4 Can you use your knowledge – 1? 

1. Write down 6 sets of non-identical mathematical twins that illustrate the 

Distributive Law. 

 

2. Write each of the following as a product of two factors

   1. 26 +x  

   2. 124 +x  

   3. 2010 +x  

   4. 129 −x  

5. 2510 −x  

6. 52 +x  

7. 49 −x  

8. 62 −− x  

9. 96 +− x  

10. x832 −  

11. x155 −−  

 

 

3. Write each of the following as the sum of two elements

   1. )(2 yx +  

   2. )32(8 −x  

   3. )5( +yx  

   4. )2( +xx  

5. )5(4 −− x  

6. )2(2 yxx +  

7. )6( −− xx  

8. )1(5
2

−yx  

9. )32(3
2 yxx −  

10. )2( baab +  

11. )9(5
23 yxy −−  

 

4. Picture this – a nicely tiled, 

rectangular swimming pool with a tiled 

border which is one tile wide. 

 

If the pool is m tiles long and n tiles wide. 

How many border tiles are there? 

 

Derive as many expressions for the 

number of border tiles as you can 

 

n

m
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5. Write down one or more non-identical mathematical twins for each of the 

following expressions

   1. xx 82
2

−  

   2. )52(4 yxx +  

   3. 
2

1810 x−  

   4. xzyz 243 −  

   5. yxx 22
2318 −  

6. )3(3 +− yxx  

7. )532( −+ zxx  

8. 
2

412 yy +  

9. )( baab +  

10. xxx 4)7( −+  

11.   )3(10 −− xx  

12.   )3()5(2 ++− yxx  

13.   )4(7)4( −+− xxx  

14.   )1()1(3 zyz −+−  

15. )4(2)4( xzxz −−−  

6. Research the mathematical terms expand and factorise.  

Explain their meanings in your own words (including examples as required). 

 

 

 

 

 

 

 

 

 

 

 

 

2. Looking at squares and other beasts. 
 

2.1 EAT 4 

Open the sequence of ClassPad 300 geometry files psquara1 to psquara4  

(in the psquare folder) and run the animations that have been added.  

As before, your task is to describe / ‘name’ the thing(s) you see. 

 

Record your descriptions.  

Compare and discuss these with your class. 

9.1  

 

 

 

2.2 EAT 5 

Repeat this for psquarb1 to psquarb4.  

 

Summarise your findings from these activities. 
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A ‘snapshot’ of psquarb4 is shown here, with some labels 

added. One group saw 

 
22 yxyxyx +++    or 

22
2 yxyx ++  

 

Can you see what they are describing? 

Can you see how they chose to describe it? 

 

Another group saw 

 
2

)( yx +  

 

Can you see what they are describing? 

Can you see how they chose to describe it? 

 

 

This implies that 
222

)(2 yxyxyx +=++  

This is known as the Perfect Square Identity. 

 

 

But why doesn’t 222
)( yxyx +=+ ? 

This common misunderstanding seems to follow from the correct application of the 

Distributive Law that says yxyx 22)(2 +=+ . 

 

As it turns out, however, you can’t “distribute” a 

“squared” like you can a “times 2” 

 

If 
222

)( yxyx +=+  then the large white square would 

have the same area as the two dark squares added. 

 

That clearly is not the case.  

 

There are two rectangles ‘missing’.  

Each has an area of xy , so there is xy2  ‘missing’. 

 

Another way to see this is through a spreadsheet.  

Open the ClassPad 300 spreadsheet file psquare2  

(in the psquare folder). 

 

 

You can see that 
22

ba +  (column E)  

is not equal to 
2

)( ba +  (column F)  

and that what is ‘missing’ is ab2  

(column G) 
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2.3 Can you use your knowledge – 2? 

1. Write down 6 examples of the Perfect Square Identity – include a minus sign in 

at least 2 of them.  

 

2. Write each of the following as the sum of three terms.

   1. 
2

)7( +x  

   2. 
2

)3( +y  

   3. 
2

)1( +x  

   4. 
2

)10( −z  

5. 
2

)5( −x  

6. 
2

)12( +x  

7. 
2

)6( −y  

8. 
2

)45( +x  

9. 
2

)8( w−  

10. 
2

)25( ji +  

11. 
2

)34( ba −  

12. 
2

)116( yx −  

 

3. Which of the following are examples of the Perfect Square Identity?

   1. 4914
2

+− xx  

   2. 9
2

+y  

   3. 164
2

++ xz  

4. 
2

)1372( yx −  

5. 1025
2

+− xy  

6. 
2

22121 zz +−  

7.       3612
2

−− xx  

8.       6416
2

++ ba  

9.       
422

4129 jiji ++  

 

4. Add the missing term to make the following Perfect Squares.

   1. 4
2

++x  

   2. 100
2

+−x  

   3. ++ yy 18
2

 

4. +− aa 12
2

 

5. 2510 +− x  

6. 364
2

++k  

7.     
22

916 yx ++  

8.     +− wxw 6025
2

 

9.     
24

49qp ++  

 

5. Change a term to make these Perfect Squares

   1. 2510
2

−− xx  

   2. 819
2

++ xy  

3.      
2

2 baba +−  

4.      
22

4123 mkmk ++  

5.   15025
2

++ pqp  

6.   
42

364816 yxyx +−  

 

6. For which parts of question 5 is there more than one correct answer?  

For those parts, provide an additional answer. 

 

7. Where possible, write the following in the form 
2

)( ba +

   1. 10020
2

++ yy  

   2. 168
2

+− xx  

   3. 96
2

+− kk  

   4. 
2

1025 mm ++  

5. 
22

2 yxyx ++  

6. 14412
2

−− aa  

7. 
2

21 zz −−  

8. 36244
2

++ aa  

9. 
22

16249 yxyx +−  

10.
22

648025 qpqp ++  

11. 
224

8118 yyxx +−  

12. 
22

364249 baba +−  
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3. And now speaking generally… 
2

)( ba + , or its non-identical twin ))(( baba ++ , is an example of a process 

sometimes called binomial expansion.  

 

Roughly translated binomial means two number, meaning that this is an example of  

a factor with two terms multiplied by another factor with two terms.  

 

What we have learned to far covered only the case where the two factors are 

identical (hence the ‘squared’). What about binomial expansion in general? 

 

3.1 EAT 6 

Consider the general binomial expansion ))(( dcba ++ . 

What sort of construction or shape would be associated with this expression? 

What does this suggest about a non-identical twin expression for ))(( dcba ++ ? 

Check that any non-identical twin does in fact return the same value as 

))(( dcba ++  for range of different inputs. 

 

9.2   

Can you prove that these expressions are equivalent, using only the identities studied 

so far in the topic? 
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3.2 Can you use your knowledge – 3? 

1. Write down 6 sets of non-identical mathematical twins where one is of the 

form ))(( dcba ++ . 

 

2. Write each of the following as the sum of four terms, and then collect like 

terms where possible. 

 

   1. )2)(5( ++ xx  

   2. )7)(6( −− yx  

   3. )15)(1( −+ xx  

   4. ))(( qxpx ++  

5.       )4)(3( −+ ba  

6.       )9)(32( −− xx  

7.       )110)(115( +− xx  

8.       )12)(43( ++ yy  

9.     )23)(45( zyx −+  

10.   )6)(6( +− xx  

11.   )1)(1( zz −+  

12.   )34)(34( baba +−  

 

3. Look at Question 2 parts 1 to 4 (above).  

These “twins” with three terms are called quadratic trinomials as they contain  

three terms, a quadratic term containing 
2

x , a linear term containing x  and  
a constant term (independent of x ). 
 

a. Explain how the coefficient of linear term can be obtained. 

b. Explain how the constant term can be obtained. 
 

4. Use this “sum and product” property to write the following as the product of 

two binomial factors. 

 

   1. 78
2

++ xx  

   2. 1610
2

++ xx  

   3. 127
2

++ xx  

   4. 103
2

−+ xx  

5. 43
2

−− xx  

6. 2811
2

+− xx  

7. 20
2

−− xx  

8. 189
2

+− xx  

9. 2411
2

++ xx  

10. 86
2

+− xx  

11. 910
2

+− xx  

12. 369
2

−− xx  

 

5. In a similar way, write the following as the product of two binomial factors. 

 

   1. 372
2

++ xx  

   2. 583
2

++ xx  

   3. 672
2

++ xx  

   4. 4125
2

+− xx  

5. 584
2

−− xx  

6. 10116
2

−+ xx  

7. 7310
2

−+ xx  

8. 15236
2

+− xx  

9. 8334
2

++ xx  

10. 21412
2

−+ xx  

11. 2410
2

−+ xx  

12. 143318
2

+− xx  

 

This process is sometimes called binomial expansion and is summarised by 

the identity 

bdbcadacdcba +++=++ ))((  

When dealing with quadratic trinomials it is sometimes written as 

 pqxqpxqxpx +++=++ )())((
2

 

 



 DRAFT

© A Harradine & A Lupton Draft, November 2008, WIP 13 

4. Another interesting case… 
 

Look closely at Question 2 parts 10, 11 and 12 on the previous page.  

You may notice that their non-identical twins differ from the twins in the 

other parts of this question.  

 

 

 

Discuss with your classmates the way that these twins differ from the others that you 

have seen. 

 

Discuss what causes this difference to come about. 

 

Write down some more pairs of twins that exhibit this behaviour. 

 

 

 

4.1 EAT 7 

Open the ClassPad 300 sequence of geometry files dsquara1 to dsquara4  

(in the dtsquare folder) and run the animations that have been added.  

 

How do these animations relate to the behaviour that you  

discussed previously? 

 

Measure aspects of these constructions to confirm your suspicions. 

9.3  

 

 

 

4.2 EAT 8 

Repeat this for dsquarb1 to dsquarb4.  

 

Write down an identity that summarises this behaviour. 
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Some snapshots of dsquara4 are seen 

here, giving some indication of what is 

represented in this construction. 

 

 

 

A labelled version of dsquarb4 is shown below. 

 

 

 

 

From the animation there seems to a link between the 

areas of the two squares and the area of the rectangle. 

 

The square’s area seems to be greater than the 

rectangle’s area. 

 

 

 

 

 

 

To look more closely at these areas a table has been 

generated, showing the areas of the large square, the 

small square and the rectangle (in that order). 

 

From it you can see that the area of the square minus the 

area of the square CD equals the area of the rectangle. 

 

This result is hinted at in the snapshot at the top of this 

page, where the two squares are equal in size and the 

rectangle has ‘disappeared’. 

 

 

 

 

 

This identity is called the Difference Of Two Squares, for obvious reasons. 

))((
22 yxyxyx +−=−  

Or to put it another way 

22
))(( yxyxyx −=+−  
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4.3 Can you use your knowledge – 4? 

1. Which of these are examples of the Difference of Two Squares identity?

   1. 36
2

−x  

   2. )1)(1( +− xx  

   3. 9
2

+y  

4. 
2

1 k−  

5. )5)(5( −− xx  

6. )1)(1( +− yy  

7. 
22

4 yx −  

8. 
42

2516 yx −  

9. 
22

81100 yx −−  

 

2. Write an equivalent expression for the following

   1. )4)(4( −+ xx  

   2. )7)(7( +− yy  

   3. )2)(2( xx +−  

4.    )12)(12( −+ xx  

5.    )3)(3( xyxy +−  

6.    )45)(45( qpqp +−  

7. )6)(6( −−+− xx  

8. )2)(2( zxyzxy −+  

9. )98)(98(
22 pnpn −+  

 

3. Write the following as the product of binomial factors.

   1. 25
2

−x  

   2. 4
2

−y  

   3. 
2

9 x−  

4. 
22

nm −  

5. 
22

4 yx −  

6. 
22

144ba −  

7. 369
2

−x  

8. 
22

4916 ba −  

9. 
22

10081 yx −   

 

4. Write the following as the product of two factors.

   1. )3(
2

+− xx  

   2. 
22

4)2( yy −−  

   3. 
22

)1( xx −−  

4.    
22

)2()3( −−+ xx  

5.    
22

)6()4( −−− xx  

6.    
22

)1()32( +−+ xx  

7. 
22

)()( yxyx −−+  

8. 
22

)2()2( yxyx −−+  

9. 
22

)()2( mnnm −−−   

By remembering that any number can be written as the square of its square root i.e. 

( )2

aa =
 

we can see the difference of two squares in many more places e.g. 

)5)(5(5
2

+−=− xxx    and   )2)(2(2
2 xyxyxy +−=−  

 

5. Write the following in the form ))(( baba +− .

   1. 3
2

−x  

   2. 10
2

−x  

   3. 
2

8 y−  

4. 
22

2nm −  

5. 
22

115 yx −  

6. ba −
2

 

7.      
42

37 wx −  

8.      
22

cba −  

9.      ( )2
2

2312 +− xx   
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5. A mixed bag… 
 

As a result of you work up to this point you should realise that, when faced with an 

algebraic expression, there are number of identities that can help you write down an 

equivalent expression. These identities include, 

 

• The Distributive Law    acabcba +=+ )(   

o  Identification is aided by spotting a common factor. 

 

• The Perfect Square identity   
222

2)( bababa ++=+  

 

• The Difference of Two Squares identity   ))((
22 bababa +−=−  

 

• The binomial expansion process    bdbcadacdcba +++=++ ))((     

or for simple quadratic trinomials   pqxqpxqxpx +++=++ )())((
2

 

 

At times the Distributive Law can be applied prior to the use of the other identities to 

aid in processes like ‘factorisation’, but this is not essential 

 

 

2

2

2

)4(3

)168(3

48243

−=

+−=

+−

x

xx

xx

  

2

2

)4(3

)4)(4(3

)4)(123(

48243

−=

−−=

−−=

+−

x

xx

xx

xx

 

 

 

5.1 Can you use your knowledge – 5? 

 

1. Write a ‘brackets free’ equivalent expression for each of the following.

   1. )3(2 yx +  

   2. )5)(3( −+ yy  

   3. 
2

)4( +− x  

   4. )32( −− xx  

 

5.     )10)(10(5 +−− zz  

6.     )53)(12(3 −+ xx  

7.     )25)(6(2 yyy −−  

8.     
2

)92(3 −− xx  

 

9.  )1(3)4(
2

++− ww  

10. )23()2(4 −−+ jiji  

11. )3)(3(
22 bbabba +−  

12. 
22

)3()2( −−+ xx  

 

3. Write these expressions as the product of factors

   1. xx 205
2

−  

   2. 44
2

−−− xx  

   3. 164
2

++ xz  

   4. xx 83
2

+−  

5. 
22

816 yxyx ++  

6. 100
2

+− x  

7. 
2

128 xyxy +  

8. 
22

1275 yx −  

9.      24273
2

−+− tt  

10.    
23

82 xyx +−  

11.    36244
2

++ aa  

12.    
22

)31()1( xx −−−  
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6. A case of mistaken identity? 
 

6.1 EAT 9 

Consider the expression 
3

152
2

−

−−

x

xx
  

Study the value that this expression takes, for a wide range of x  values. 

Represent these values in a number of ways. 

Suggest a non-identical twin for this expression. 

Present an argument supporting your suggestion. 

9.4  
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Looking at expressions like 
1

23
2

+

−+

x

xx
 in a number of ways can be quite revealing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

As a table of values or as a graph, this complex looking expression behaves in a 

relatively simple way. 

 

If you are familiar with linear or ‘constant adder’ patterns you might even suggest 

that, except for 1−=x , this behaviour can be described by the expression x−3 . 

 

In effect this is making the conjecture that  

x
x

xx
−=

+

−+
3

1

23
2

for 1−≠x  

By writing down equivalent expressions, this conjecture can be proved i.e. 

x

xifx

x

xx

x

xx

x

xx

−=

−≠−−=

+

+−−
=

+

−−−
=

+

−+

3

1)3(

1

)1)(3(

1

)32(

1

23

2

2

 

The third and fourth lines above are equivalent (i.e. return the same value for a given 

input) because, for example  )37(4
8

84
−−=−=

×−
 (the case where 7=x )  

except in the case where 1−=x  because 
0

0)4( ×−−
 cannot be defined but 

4)31( =−−− .  

Multiplying by zero generally gives the result of zero, regardless of other values. 

Dividing by zero generally gives an infinitely large result, regardless of other values. 

These conflicting processes mean that the expression cannot be defined for 1−=x  

so, in summary 

x
x

xx
−=

+

−+
3

1

23
2

for 1−≠x  

1

23
2

+

−+

x

xx
is undefined for 1−=x  
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6.2 Can you use your knowledge – 5? 

1. Use a similar approach to write down simpler looking non-identical twins for 

these expressions. Clearly identify the values for which these expressions are 

not equivalent to their simpler looking twin. 

 

   1. 
12

48

−

−

x

x
 

   2. 
42

2010

+

+

x

x
 

   3. 
68

1824

−

+

x

x
 

   4. 
2012

159

−

−

y

y
 

5. 
x

xx 5
2

+
 

6. 
x

xx
2

27 −
 

7. 
2

24
3

x

xx −
 

8. 
1

1
2

−

−

x

x
 

9. 
1

45
2

+

++

x

xx
 

10. 
2

107
2

−

+−

x

xx
 

11. 
32

9124
2

−

+−

x

xx
 

12. 
4

2032
2

+

−+

x

xx
 

 

For Example 

6234

116
2

2

−−

−

xx

x
 

 

)6)(14(

)14)(14(

−+

+−
=

xx

xx
 

 

                    
4

1
..014

6

14
−≠≠+

−

−
= xeixif

x

x
 

 

 

 

2. Tackle these in a similar way 

   1. 
xx

xx

7

145
2

2

+

−+
 

   2. 
45

82
2

2

++

−+

xx

xx
 

   3. 
4

44
2

2

−

+−

x

xx
 

   4. 
2

2

1 x

xx

−

+
 

5. 
243

166
2

+

−+

x

xx
 

6. 
96

372
2

2

+−

+−

xx

xx
 

7. 
xx

xx

124

3042
2

2

−

−+
 

8. 
1

1
2

2

+−

−−

xx

xx
 

9. 
369

189
2

2

−

−

x

xx
 

10. 
25204

10196
2

2

+−

+−

xx

xx
 

11. 
22

bybx

ayax

−

−
 

12. 
xyy

yx

4

16
2

22

−

−
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7. A funny looking twin indeed! 
 

Asked for a non-identical mathematical twin for 86
2

++ xx  a student provided the 

answer 1)3(
2

−+x . Were they wrong? 

 

When asked how this was obtained they replied 

“I knew the perfect square 
2

)3( +x  would give me ...6
2

++ xx  (as required) 

 but would also give 9... + , and so I subtracted 1 to make it 8... + .” 

 

This technique is called Completing the Square, as we create a perfect square 
2

)( ax + , and then complete it with a constant term, to construct an equivalent 

expression. 

 

7.1 Can you use your knowledge – 6? 

1. Which perfect square has a twin that looks like, 

 

   1. ...10
2

++ xx  

   2. ...10
2

+− xx  

   3. ...2
2

++ xx  

4. ...18
2

++ yy  

5. ...4
2

+− tt  

6. ...30
2

+− kk  

7. ...5
2

++ xx  

8. ...3
2

+− xx  

9. ...2
2

++ axx  

 

2. Complete the right hand side to make these expressions equivalent 

 

   1. ...)4(78
22

+=++ xxx  

   2. ...)3(36
22

−=+− xxx  

   3. ...)7(914
22

+=−+ xxx  

   4. ...)6(5012
22

−=+− mmm  

5. ...)10(20
22

−=− yyy  

6. ...)(1
2

2
12

+=++ xxx  

7. ...)5.3(17
22

−=−− xxx  

8. ...)4.0(2.08.0
22

−=−− xxx

 

3. Use the method of Completing the Square to write down a non-identical 

mathematical twin of the form khx ++
2

)(  for the following 

 

   1. 14
2

++ xx  

   2. 2016
2

++ xx  

   3. 1010
2

−− xx  

   4. 32
2

−− xx  

5. 25
2

++ xx  

6. 10040
2

++ tt  

7. 99
2

++ xx  

8. yy 8
2

+  

9. 83
2

++ xx  

10. 107
2

−− xx  

11. 2
2

−+ yy  

12. 511
2

−− xx  
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This technique can be extended so that is it applies to all quadratic trinomials by the 

careful use of the distributive law e.g. 

 

4
52

2
3

4
92

2
3

4
92

2
3

2

2

)(

1)(

1])[(

1)3(

13

+−−

−+−−

−−−−

−−−

−+−

x

x

x

xx

xx

   

39)4(2

732)4(2

7]16)4[(2

7)8(2

782

2

2

2

2

2

−+=

−−+=

−−+=

−+=

−+

x

x

x

xx

xx

 

 

4. Use the method of Completing the Square to write down a non-identical 

mathematical twin of the form khxa ++
2

)(  for the following, 

 

   1. 3162
2

++ xx  

   2. 11303
2

−+ xx  

   3. xx 82
2

−  

   4. 2305
2

+− xx  

5. 1014
2

++− xx  

6. 3242
2

+−− xx  

7. 52
2

−−− xx  

8. 1124
2

+− xx  

9. 8333
2

++− xx  

10. 20455
2

+− xx  

11. 232
2

+− xx  

12. 352
2

−+ xx  
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8. The magic of Algebra! 
 

8.1 EAT 10 

Think of any odd number. 

Square it. 

Write down the number one less than this square number. 

 

Repeat for 4 other odd numbers. 

 

What property do the 5 numbers that you have written down have in common? 

 

Can you prove that the result of this process will always share this property? 
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Number tricks such as the one in EAT 10 can often be analysed using algebraic 

identities like those you have been studying. 

 

You should have seen that if you 

• Think of any odd number. 

• Square it. 

• Write down the number one less than this square number. 

 

You seem always get a multiple of 4, or at least it seems that way.  

 

The question is whether or not this result could be proved for the infinite number of 

odd numbers that we could think of. 

 

If we let x  represent any integer (some write this as Rx ∈ ). 

Then the expression 12 +x  represents all odd integers. 

The square of this can now be written as a number of non-identical twins 

1)(4

144

)12(

2

2

2

++=

++=

+

xx

xx

x

 

This last twin was carefully chosen to show that this square of any odd number is 

always one greater than a multiple of 4! 

 

8.2 Can you use your knowledge – 5? 

For these number tricks, do them three or four times so that you see what is going on, 

then prove it to be so for all cases…! 

 

1. Choose any integer and write it down. 

 Write down its square. 

 Now write down the product of the integers “either side” your first number. 

 

What do you notice about the two numbers that you have written down? 

Can you prove it to be so for all cases? 

 

2. Find the sum of any 5 consecutive integers and write it down. 

Repeat for three or four different sets of 5 consecutive integers. 

 

What property do these values share? 

Prove that is true for all possible sets of 5 consecutive integers. 

 

3. Choose any integer. 

 Multiply it by the integers “either side” of it. 

 Add your original integer. 

Write down any ten consecutive integers that include this result. 

 

Show you maths teacher and be amazed when they tell you what your 

original integer was! 

 

4. List the square numbers (starting with zero). 

 Now list the gaps between consecutive square numbers. 

  

What do you notice? 

 Prove it to be so. 
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9. eTech Support. 
 

9.1 Opening a geometry file and animating it. 

Enter the G mode of your ClassPad 300.  

Go to the File drop down menu and tap Open.  

 

View the contents of the folder that you require  

(on the right we see the contents of the distrib folder)  

by tapping on the black triangle (changing it to $). 

 

Tap on the file that you wish to open (i.e. dista1) and 

then click Open. 

 

 

 

 

 

 

With a file that is able to be animated (like the ones in this 

unit), the sequence required to run an animation is,  

• go to the Edit menu,  

• select Animate and then tap  

o Go (once) – for a single “run through” or  

o Go (to and fro) – for continual 

animation (stopped by c) 

 

 

For more control over the animation, open the Animation 

User Interface by going to the View menu and tapping on 

Animation UI. This changes the tool bar to 

 

 

 

 

 

The standard toolbar is restored by repeating the above procedure 

 

Using this interface the horizontal slider can be used to see 

the animation ‘frame by frame’ – use the left and right arrows or drag the white box. 

 

In addition the left drop down menu (tap $) can be used to control the animation 

with keys such as 

 
 Go (once) 

 
 Go (to and fro)  

 
 Stop 
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9.2 Tabulating an expression in a spreadsheet. 

Enter the  mode of your ClassPad 300. Open a new spreadsheet by tapping 

New in the File menu. Type a, b, c and d into the first four cells in row 1. 

Type ))(( dcba ++  into the fifth cell in row 1 (i.e. E1).  

Type your non-identical mathematical twin in F1. 

 

 

 

To fill the first 100 cells of columns with random integers 

between – 9 to 9 go to the Edit menu and choose the 

command Fill RangeFill RangeFill RangeFill Range. 

 

Enter the formula rand(-9,9) with a range of A2:D101. 

 

 

 

To compute the value of the expression ))(( dcba ++  for 

the 100 sets of randomly chosen a, b, c and d values, 

enter this expression in Column E in the following way, 

 

With the cursor in cell E2 use the fill range command and enter the formula 

=(A2+B2)×(C2+D2) with a range of E2 to E101. 

 

Use a similar method to enter your non-identical  

mathematical twin in column F and then compare the two columns.  

 

 

 

Another useful command to tidy up your spreadsheet is 

AutoFit SelectionAutoFit SelectionAutoFit SelectionAutoFit Selection from the Edit menu.  

With column selected, this command will modify the 

column width to fit its contents. 

 

Cell alignment of selected cells can be changed  

from [ to x using the drop down menu in the centre of 

the toolbar. 

 

 

 

Your ‘finished product’ should look something like this. 

 

If you wish to Save your spreadsheet you will find this 

command in the File menu. 
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9.3 Measuring aspects of geometric constructions. 

Any aspect of a geometric construction can be 

measured by the ClassPad 300.  

 

All you need to do is select the features that define the 

thing you want to measure.  

 

For example, if you want to measure the area of a shape 

you need to select (by tapping) all the line segments that 

make it up, or alternatively select all its vertices. 

  

With your selection made tap on the black triangle 

 

on the right side of the tool bar 2.  

This will take you to the measurement box as shown right. 

 

With the measurement box showing your selections can be changed and different 

aspects of the construction can be measured. 

 

Note:  

• Tap on blank space to deselect all. 

• If the measurement box is blank you have not selected the features needed 

to define the aspect you wish to measure. Try again. 

 

Tabulating measured quantities. 

If you have previously run an animation that involved the 

thing you have measured, then the values of this  

(and every other) aspect of the construction is stored 

for each ‘step’ of the animation  

 

With the measurement of interest visible in the 

measurement box tap on the table icon #. 

 

A table will be displayed in the newly split window. 

 

By repeating this process of selection, measurement and 

tabulation, the table can be added to, so that quantities 

can be compared. 

 

 

With columns of the table selected, the Edit menu can be used to copy this data, 

which then can be pasted into a , amongst other places. 

                                                 

 

 
2
 The Animation User Interface (UI) may need to be turned off in the View menu 
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9.4 Tabulating an expression involving a single variable. 

One of the easy ways to look at values that an algebraic expression takes for a range 

of inputs is by using the W mode of a ClassPad 300. 

 

Enter the expression into y1 as )3()152(
2

−÷−− xxx . 

 

 

 

Tap on 8 to set the Table Input. 

 

 

 

 

Tap on # to see the table in the bottom of a newly split 

screen. Tap r if you wish to enlarge the table. 

 

 

 

Plotting the values of an expression. 

 

To set the View Window for a plot of the values in a table tap 6.  

 

Given the values seen in our table the settings seen left could be 

used in the drawing of a plot. 

 

 

Tap ! to plot the values on your chosen View Window. 

 

By first tapping r and then selecting Square from the 

Zoom menu a more comprehensive and accurate plot is 

obtained. 
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10. Answers. 
1.4 

Can you use your 

knowledge – 1? 

  

2.1 )13(2 +x  

2.2 
)62(2

)3(4

+

+

xor

x
 

2.3 

)105(2

)42(5

)2(10

+

+

+

xor

xor

x

 

2.4 )4(3 −x  

2.5 )252(5 −x  

2.6 

...

)(4

)(2

4
5

2
1

2
5

or

xor

x

+

+

 

2.7 

...

)1(4

)(9

4
9

9
4

or

xor

x

+

+

 

2.8 

)62(

)3(2

)3(2

+−

−−

+−

xor

xor

x

 

2.9 

)66(

)32(3

)32(3

−−

+−

−−

xor

xor

x

 

2.10 

)416(2

)28(4

)4(8

xor

xor

x

−

−

−

 

2.11 

)155(

)31(5

)31(5

xor

xor

x

+−

−−

+−

 
  

3.1 yx 22 +  

3.2 2416 −x  

3.3 xxy 5+  

3.4 xx 2
2

+  

3.5 204 +− x  

3.6 xyx 42
2

+  

3.7 xx 6
2

+−  

3.8 
22

55 xyx −  

3.9 yxx 23
96 −  

3.10 22
2abba +  

3.11 
432

545 yyx +−  

  

4 

11

11

)2)(2(

)1(2)1(2

422

++++

++++

−++

+++

++

nm

nm

mnnm

nm

nm

 

  

5.1 

22

22

2

6)(8

8

)4(2

)82(

)4(2

xxx

xxx

xx

xx

xx

−+

+−

−

−

−

 

5.2 
)104(2

208

2

2

xyx

xyx

+

+
 

5.3 
)8.11(10

)95(2

2

2

x

x

−

−
 

5.4 

)8(3

)243(

)8(3

xzyz

xyz

xyz

−

−

−

 

5.5 
)2318(

)2318(
2

xyxx

yx

−

−
 

5.6 
)3(3

933

2

2

xxyx

xxyx

+−

+−
 

5.7 

xxyxy

xyxx

xxzx

5

532

22

2

−++

+++

−+

 

5.8 

)412(

)3(4

)3(4
2

yy

yy

yy

+

+

+

 

5.9 

)(

)(

2

2

22

abab

baba

abba

+

+

+

 

5.10 

)3(

)47(

3

47

2

2

+

−+

+

−+

xx

xx

xx

xxx

 

5.11 
xxxx

xx

−−−−

−−

2

2

10

310
 

5.12 
10)5(

3102

−+

++−

yx

xxyx
 

5.13 

283

2874

)3)(4(

2

2

−+

−+−

+−

xx

xxx

yx

 

5.14 
yzyz

yz

−+−

+−

33

)3)(1(
 

5.15 

zxz

xz

xzxz

xzzzx

xzzzzx

123

)4(3

)4(2)4(

212

284

−

−

−+−

+−

+−−

 

  

2.3 
Can you use your 

knowledge – 2? 

  

2.1 4914
2

++ xx  

2.2 96
2

++ yy  

2.3 12
2

++ xx  

2.4 10020
2

+− zz  

2.5 2510
2

+− xx  

2.6 144
2

++ xx  

2.7 3612
2

+− yy  

2.8 164025
2

++ xx  

2.9 2
1664 ww +−  

2.10 
22

42025 jiji ++  

2.11 22
92416 baba +−  

2.12 
2

12113236 yxyx +−

 

  

3 

 

1, 4, 6, 8, 9 

 

4.1 x4  
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4.2 20  

4.3 81 

4.4 36  

4.5 2
x  

4.6 k24  

4.7 xy24  

4.8 2
36x  

4.9 qp2
14  

  

5.1 2510
2

+− xx  

5.2 8118
2

++ yy  

5.3 22
2 baba +−  

5.4 22
4129 mkmk ++  

5.5 
2

2

25

5025

q

pqp

+

+
 

5.6 
4

22

36

4816

y

xyx

+

−
 

  

6.1 Only one answer 

6.2 4
812

9 ++ yy  

 

6.3 
2

2 bbaa +−  

 

6.4 
22

4343 mkmk ++

 

6.5 
11025

2
++ pp  

 

6.6 
22

364816 yxyx +−

 

  

7.1 
2

)10( +y  

7.2 
2

)4( −x  

7.3 
2

)3( −k  

7.4 
2

)5( m+  

7.5 
2

)( yx +  

7.6 Not possible 

7.7 Not possible 

7.8 
2

)62( +a  

7.9 
2

)43( yx −  

7.10 
2

)85( qp +  

7.11 
22

)9( yx −  

7.12 Not possible 

3.2 
Can you use your 

knowledge – 3? 

  

2.1 
107

1025

2

2

++

+++

xx

xxx
 

2.2 
4213

4276

2

2

+−

+−−

yy

yyy
 

2.3 
1514

1515

2

2

−−

−+−

xx

xxx
 

2.4 pqqxpxx +++
2

 

2.5 1243 −−+ abab  

2.6 27212

273182

2

2

+−

+−−

xx

xxx

 

2.7 

15150

110

15150

2

2

−+

−−

+

xx

x

xx

 

2.8 
4116

4386

2

2

++

+++

yy

yyy
 

2.9 
zxz

yxy

810

1215

−−

+
 

2.10 
36

3666

2

2

−

−+−

x

xxx
 

2.11 2
1 zzz −−+  

2.12 
22

2

2

916

912

1216

ba

bab

aba

−

−+

−

 

  

4.1 )7)(1( ++ xx  

4.2 )2)(8( ++ xx  

4.3 )4)(3( ++ xx  

4.4 )2)(5( −+ xx  

4.5 )1)(4( +− xx  

4.6 )7)(4( −− xx  

4.7 )4)(5( +− xx  

4.8 )6)(3( −− xx  

4.9 )3)(8( ++ xx  

4.10 )2)(4( −− xx  

4.11 )9)(1( −− xx  

4.12 )3)(12( +− xx  

5.1 )3)(12( ++ xx  

5.2 )1)(53( ++ xx  

5.3 )2)(32( ++ xx  

5.4 )2)(25( −− xx  

5.5 )52)(12( −+ xx  

5.6 )52)(23( +− xx  

5.7 )1)(710( +− xx  

5.8 )56)(3( −− xx  

5.9 )8)(14( ++ xx  

5.10 )32)(76( +− xx  

5.11 )32)(85( −+ xx  

5.12 )23)(76( −− xx  

  

4.3 
Can you use your 

knowledge – 4? 

  

1 

 

1, 2, 4, 6, 7, 8 

 

  

2.1 16
2

−x  

2.2 49
2

−y  

2.3 2
4 x−  

2.4 14
2

−x  

2.5 
22

9yy −  

2.6 
22

1625 qp −  

2.7 36
2

−x  

2.8 
222

4zyx −  

2.9 
42

8164 pn −  

  

3.1 )5)(5( +− xx  

3.2 )2)(2( +− yy  

3.3 )3)(3( xx +−  

3.4 ))(( nmnm +−  

3.5 )2)(2( yxyx +−  

3.6 )12)(12( baba +−  

3.7 
)2)(2(9

)63)(63(

+−

+−

xx

xx
 

3.8 
)74)(74( baba +−

 

3.9 
)109)(109( yxyx +−
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4.1 
)32(3

)]3([

)]3([

+

++×

+−

x

xx

xx

 

4.2 

)23)(2(

)23)(2(

]2)2[(

]2)2[(

−+−

−−−

+−×

−−

yy

yy

yy

yy

 

4.3 
1)12(

)]1([

)]1([

×+

−+×

−−

x

xx

xx

 

 

4.4 

 

)12(5

)]2()3[(

)]2()3[(

+

−++×

−−+

x

xx

xx

 

 

4.5 

 

)5(4

)102(2

)]6()4[(

)]6()4[(

+

+

−+−×

−−−

x

x

xx

xx

 

 

4.6 
)43)(2(

)]1()32[(

)]1()32[(

++

+++×

+−+

xx

xx

xx

 

4.7 

xy

xy

yxyx

yxyx

4

22

)]()[(

)]()[(

×

−++×

−−+

 

4.8 

 

)3)(3(

)]2()2[(

)]2()2[(

yxyx

yxyx

yxyx

−+

−++×

−−+

 

4.9 

 

)32(

))(32(

)]()2[(

)]()2[(

nmn

nnm

mnnm

mnnm

−−

−−

−+−×

−−−

 

5.1 ( )( )33 +− xx  

5.2 
( )( )1010 +− xx

 

5.3 

( )( )
( )( )yy

yy

+−

+−

2222

88

 

5.4 
( )( )nmnm 22 +−

 

5.5 
( )

( )yx

yx

115

115

+×

−
 

5.6 ( )( )baba +−  

5.7 
( )

( )2

2

37

37

wx

wx

+×

−
 

5.8 
( )( )cbacba +−

 

5.9 

 

  

5.1 
Can you use your 

knowledge – 5? 

  

1.1 yx 62 +  

1.2 152
2

−− yy  

1.3 168
2

−−− xx  

1.4 xx 32
2

+−  

1.5 5005
2

+− z  

1.6 152118
2

−− xx  

1.7 
yyy 60344

23
−+−

 

1.8 
x

xx

343

5412
23

−

+−
 

1.9 195
2

+− ww  

1.10 ijji 3410 −+  

1.11 224
9bba −  

1.12 510 −x  

2.1 )4(5 −xx  

2.2 
2

)2( +− x  

2.3 )8)(2( ++ zz  

2.4 )83( −− xx  

2.5 
2

)4( yx +  

2.6 )10)(10( −+− xx  

  2.7 )32(4 yxy +  

2.8 
)25(

)25(3

yx

yx

+×

−
 

2.9 )8)(1(3 −−− tt  

2.10 
)2(

)2(2

yx

yxx

+×

−−
 

2.11 
2

)62( +a  

2.12 )24(2 −− xx  

  

6.2 
Can you use your 

knowledge – 6 ? 

  

1.1 

2
14

12

)12(4

≠=

−

−

xif

x

x

 

1.2 

25

42

)42(5

−≠=

+

+

xif

x

x

 

1.3 

4
33

68

)68(3

−≠=

+

+

xif

x

x

 

1.4 

3
5

4

3

)53(4

)53(3

≠=

−

−

yif

y

y

 

1.5 

05

)5(

≠+=

+

xifx

x

xx
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7.1 
Can you use your 

knowledge – 7 ? 
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